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前言
简介

本章包含使用MPLAB® ICD 3在线调试器前需要了解的一般信息。内容包括：

• 文档编排

• 本指南使用的约定

• 推荐读物

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXXXXA_CN”，其中 “XXXXXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
DS50002081B_CN 第6页  2015 Microchip Technology Inc.
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前言
文档编排

本文档介绍了如何使用MPLAB ICD 3在线调试器作为开发工具在目标板上仿真和调试
固件，以及如何编程器件。文档内容编排如下：

第1部分——入门

• 第1章“关于调试器”——介绍了MPLAB ICD 3在线调试器以及其如何帮助开发  
应用。

• 第2章“工作原理” ——讲述了MPLAB ICD 3在线调试器的工作原理。介绍了配   
置选项。

第2部分——功能

• 第3章“调试器使用” ——介绍了选择MPLAB ICD 3在线调试器作为调试工具时   
MPLAB X IDE中提供的基本调试功能。其中包括断点和跑表等调试功能。

第2部分——故障诊断

• 第4章“故障诊断首要步骤”——调试器运行出现问题时首先应该尝试的操作。

• 第5章“常见问题解答（FAQ）”——常见问题列表，有利于故障诊断。

• 第6章“错误消息” ——错误消息和建议解决方案的列表。

• 第7章“工程技术说明（ETN）”

第3部分——参考信息

• 附录A“调试器功能汇总”——介绍了选择MPLAB ICD 3调试器作为调试或编程工  
具时MPLAB X IDE中的调试器功能汇总。

• 附录B“硬件规范”——调试器系统的硬件和电气规范。

• 附录C“版本历史”
 2015 Microchip Technology Inc. DS50002081B_CN 第7页
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本指南使用的约定

本指南采用以下文档约定：

文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ……为仅有的编译器 ……

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 Enable Programmer

引用 窗口或对话框中的字段名 “Save project before build”

带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK

选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数字，其中 N
为总位数， R 为基数， n 为
其中一位。

4‘b0010， 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按下 <Enter>， <F1>

Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm， _endasm， static

命令行选项 -Opa+，-Opa-

二进制位值 0， 1

常量 0xFF， ‘A’

斜体 Courier New 可变参数 file.o， 其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [选项] file [选项]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

DS50002081B_CN 第8页  2015 Microchip Technology Inc.
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推荐读物

本用户指南介绍了如何使用MPLAB ICD 3在线调试器。下面列出了其他有用的文档。  
以下Microchip文档均已提供，并建议读者作为补充参考材料。

多工具设计忠告（DS51764C_CN）

请先阅读本文档！其中包含有关在使用MPLAB ICD 3进行目标设计时应考虑的操作问  
题的重要信息。

MPLAB ICD 3在线调试器的版本说明

有关使用MPLAB ICD 3在线调试器的最新信息，请阅读MPLAB X IDE Start Page（起    
始页）上“Release Notes and Support Documentation”（版本说明和支持文档）下    
的说明。版本说明包含了本用户指南中可能未提供的更新信息和已知问题。

MPLAB X——使用MPLAB ICD 3在线调试器海报（DS52011A_CN）

本海报说明了如何使用标准通信和目标板为MPLAB ICD 3在线调试器连接硬件和安装  
软件。

MPLAB ICD 3在线调试器用户指南（DS51766A_CN）

调试器的综合用户指南。其中涵盖调试器的使用方法、故障排除以及硬件规范。

MPLAB ICD 3在线调试器在线帮助文件

MPLAB X IDE随附了全面的调试器帮助文件。内容涵盖了调试器的使用、故障诊断和  
硬件规范。此帮助文件可能包含比本文档中更新的信息。

Processor Extension Pak and Header Specification（DS51292）

本小册子介绍了如何安装和使用调试头来更好地调试所选器件，而无需占用额外的引
脚和资源。另请参见PEP和调试头在线帮助文件。

Transition Socket Specification（DS51194）

可参考本文档获取有关适用于调试头的转换插座的信息。
 2015 Microchip Technology Inc. DS50002081B_CN 第9页
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第1章 关于调试器
 

1.1 简介

本章提供了MPLAB ICD 3在线调试器系统的概述。

• MPLAB ICD 3在线调试器的定义

• MPLAB ICD 3在线调试器提供的功能

• MPLAB ICD 3在线调试器组件

1.2 MPLAB ICD 3在线调试器的定义

MPLAB ICD 3在线调试器是一款通过在Windows®平台上运行MPLAB X IDE软件的PC   
控制的在线调试器。MPLAB ICD 3在线调试器是开发工程师工具套件中不可缺少的部  
分，可用于从软件开发到硬件集成等各种应用领域。

MPLAB ICD 3 在线调试器是一款用于为基于在线串行编程（ In-Circuit Serial   
Programming™，ICSP™）和增强型在线串行编程2线串行接口的Microchip PIC®单片 
机（MCU）和dsPIC®数字信号控制器（Digital Signal Controller，DSC）进行软硬件  
开发的复杂调试器系统。

由于该调试器系统使用带有内置仿真电路的器件（而非特殊调试器芯片）， 因此执行 
代码的方式与实际器件相似。用户可以交互方式访问给定器件的所有可用功能，且可
通过MPLAB X IDE界面设置和修改这些功能。

MPLAB ICD 3调试器专为调试具有丰富调试功能的嵌入式处理器而开发，这种嵌入式  
处理器与传统系统处理器存在以下区别：

• 处理器以最大速度运行

• 能够集成 I/O端口数据输入

除了调试器功能外，MPLAB ICD 3在线调试器系统还可用作器件生产编程器。
 2015 Microchip Technology Inc. DS50002081B_CN 第11页
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DS
1.3 MPLAB ICD 3在线调试器提供的功能

MPLAB ICD 3在线调试器系统允许您：

• 在自己的硬件上实时调试您的应用程序

• 使用硬件断点进行调试

• 使用软件断点进行调试

• 基于内部事件设置断点

• 监视内部文件寄存器

• 全速仿真

• 编程器件

1.4 MPLAB ICD 3在线调试器组件

MPLAB ICD 3在线调试器系统的组件有：

• 带指示灯的MPLAB ICD 3

• 提供调试器和PC之间的通信并为调试器供电的USB电缆

• 将MPLAB ICD 3连接到调试头模块或目标板的电缆

• ICD 3测试接口板

图1-1： 基本调试器系统

可单独订购的其他硬件：

• 转换插座

• ICD调试头

• MPLAB处理器扩展工具包

USB 电缆

指示灯
 

连接到目标板、

ICD 3 测试接口板

调试头或 ICD 3
测试接口板的
模块化电缆
50002081B_CN 第12页  2015 Microchip Technology Inc.
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第2章 工作原理
2.1 简介

本章简要概述了MPLAB ICD 3在线调试器系统的工作原理。旨在提供足够的信息，来  
帮助用户设计与调试器兼容的目标板，以进行调试和编程操作。还讨论了在线调试和
编程的基本原理，以便用户能够快速地解决遇到的问题。

• 工具比较

• 调试器与目标板之间的通信

• 目标板通信连接

• 调试

• 调试要求

• 编程

• 调试器使用的资源
 2015 Microchip Technology Inc. DS50002081B_CN 第13页
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2.2 工具比较

MPLAB ICD 3在线调试器系统与Microchip的其他调试工具在物理和操作方面有所不  
同，如下表所示。特殊功能因器件不同而异——有关详细信息，请参见Microchip网站
上的开发工具选择器（Development Tools Selector，DTS）。

表2-1： 调试工具比较 

功能
MPLAB® ICD 3
在线调试器

PICkit™ 3 编程器 /
调试器

MPLAB REAL ICE™
在线仿真器

USB速度 高速和全速 仅全速 高速和全速

USB驱动程序 Microchip HID Microchip

USB供电 有 有 有

为目标供电 有 有 无

可编程VPP和VDD 有 有 有

从目标板灌入Vdd的电流 <50 μA 20 mA <50 μA

过压 /过流保护 有（硬件） 有（软件） 有（硬件）

器件仿真 全速 全速 全速

硬件断点 复杂 简单 复杂

跑表 有 有 有

软件断点 有 无 有

程序映像 无 512 KB 无

序列化USB 有 有 有

跟踪 无 无 有

数据捕捉 无 无 有

逻辑探针触发器 无 无 有

高速 /LVDS连接 无 无 有

生产编程器 有 无 有
DS50002081B_CN 第14页  2015 Microchip Technology Inc.



工作原理
2.3 调试器与目标板之间的通信

以下小节介绍了调试器系统配置。 

2.3.1 标准 ICSP器件通信

可将调试器系统配置为使用标准 ICSP通信执行编程和调试功能。此6引脚连接方式与
以前的MPLAB ICD 2在线调试器使用的连接方式相同。

模块化电缆可以插入到：

• 目标板上与之匹配的插座中，其中目标器件在目标板上（图2-1），或

• 标准适配器/调试头板组合（作为处理器套件提供）中，然后插入目标板（图2-2）。

关于标准通信的更多信息，请参见附录B“硬件规范”。

图2-1： 标准调试器系统——内置 ICE电路的器件

警告

通信故障。
请勿在安装软件和USB驱动程序之前连接硬件。

警告

调试器或目标板损坏。
请勿在调试器主机或目标板上电时更改硬件连接。

注： 以前的调试头板使用6引脚（RJ-11）模块化连接器，而非8引脚连接器，所
以这些调试头可以直接连接到调试器。

目标板

目标器件或 PIM

电源
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图2-2： 标准调试器系统——ICE器件

目标板

转换插座

器件-ICE

处理器套件

标准适配器调试头

器件-ICE

ICD调试头

或

电源
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工作原理
2.4 目标板通信连接

2.4.1 标准通信目标板连接

MPLAB ICD 3在线调试器通过RJ-11连接器经模块化接口（6芯）电缆连接到目标器  
件。连接器的引脚编号显示在目标PCB的底部，如图2-3所示。

图2-3： 目标板上的标准连接

2.4.2 目标板连接电路

图2-4显示了MPLAB ICD 3在线调试器与目标板上连接器的互连情况。该图还显示了从  
连接器到目标PCB上器件的连线。建议在VPP/MCLR线与VDD之间接一个上拉电阻（通
常约为50 k），这样可将线路置为低电平以复位器件。

图2-4： 目标电路的标准连接

注： 调试器和目标板上的电缆连接互为镜像，即电缆一端上的引脚1连接到电缆
另一端的引脚6。请参见第B.5.2.3节“模块化电缆规范”。

1

2

3

4

5

6

目标连接器

VPP/MCLR
Vss

PGC
VDD

PGD
LVP

目标PCB底部

VDD

VPP/MCLR

PGC

PGD

VSSAVDD

AVSS

2

1

5

4

3

用户复位

50K

接口连接器

应用 PCB

器件
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2.4.3 目标供电

在下面的说明中，将只谈到与关键调试器操作相关而且有效的三根线：引脚 1
（VPP/MCLR）、引脚5（PGC）和引脚4（PGD）。图2-4中显示了引脚2（VDD）和
引脚3（VSS）是出于完整性考虑。MPLAB ICD 3为给目标器件供电提供了两种配置：  
内部调试器电源和外部目标电源。

推荐使用来源于目标应用的外部电源。在此配置中，目标VDD由调试器检测，以允许
进行电平转换使之适用于目标低电压操作。如果调试器在其VDD线（接口连接器的引
脚2）上检测不到电压，它将不能工作。

2.4.4 调试器供电

内部调试器电源在两个方面受到限制：

- 电压范围不够宽（3-5V）

- 供电电流大小限制为100 mA

这对于那些为独立编程而将器件VDD与应用电路的其余部分隔离开的小型应用很有
用，但是不推荐普遍使用，因为它对源自PC的USB供电系统有更高的电流要求。

注意，目标VDD由调试器检测，以允许进行电平转换使之适用于目标低电压操作。如
果调试器在其VDD线（接口连接器的引脚2）上检测不到电压，它将不能与目标通信。

不是所有的器件都有AVDD和AVSS线，但是如果目标器件上有这两根线，为了调试器能
够正常工作，必须将它们连接到适当的电平。它们不能处于悬空状态。

通常，建议将所有VDD/AVDD和VSS/AVSS线连接到适当的电平。同时，带VCAP线的器
件（例如PIC18FXXJ MCU）应该连接到适当的电容或电平。

注： 相互连接非常简单。发生的所有问题通常是由这几根关键线上的其他连接
或元器件影响MPLAB ICD 3在线调试器系统的运行引起的，下一节将对此  
进行讨论。
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工作原理
2.4.5 影响调试器正常运行的电路

图2-5显示了在调试器的有效线上连接某些元器件会影响MPLAB ICD 3在线调试器系统  
正常运行。

图2-5： 不正确的电路元器件

确切地说，必须遵循以下准则：

• PGC/PGD不要接上拉——上拉会破坏电压值，因为这些线在调试器中有4.7 k的 
下拉电阻。

• PGC/PGD不要接电容——在编程和调试通信期间，它们会阻止数据线和时钟线上
电平的快速变化。

• MCLR不要接电容——它们会阻止VPP的快速变化。通常一个简单的上拉电阻就已
足够。

• PGC/PGD不要接二极管——它们会阻止调试器和目标器件间的双向通信。

不允许！

不允许！

不允许！

VPP/MCLR

PGC

PGD

1

5

4

接口连接器

不
允许！
 2015 Microchip Technology Inc. DS50002081B_CN 第19页



用于MPLAB X IDE的MPLAB® ICD 3用户指南
2.5 调试

使用MPLAB ICD 3在线调试器系统作为调试器有两个步骤。第一个步骤要求将应用程  
序烧写到目标器件中（MPLAB ICD 3可用于此过程）。第二步使用目标闪存器件的内  
部在线调试硬件来运行和测试应用程序。这两步与MPLAB X IDE操作直接相关：

1. 将代码烧写到目标器件并激活具体的调试功能（详细信息请参见下一节）。

2. 使用调试器设置断点并运行。

如果目标器件不能被正确编程，则MPLAB ICD 3在线调试器将无法进行调试。

图2-6显示了编程所要求的基本电路互连。注意这与图2-4相同，为清楚起见，不显示
调试器的VDD和VSS线。

图2-6： 编程要求的正确连接

上图显示了MPLAB ICD 3在线调试器的一些内部接口电路的简化框图。编程时，目标  
器件不需要时钟，但必须为其提供电源。编程时，调试器在VPP/MCLR上施加编程电
压，通过PGC发送时钟脉冲并通过PGD发送串行数据。要校验器件是否已被正确编
程，可以向PGC发送时钟，并通过PGD读回数据，这符合开发阶段所使用器件的ICSP
协议。更多详细信息，请参见器件编程规范。

+5V

编程电压

4.7 k

4.7 k

VPP/MCLR

PGC

PGD

1

5

4

内部电路

VSS

VDD
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工作原理
2.6 调试要求

要使用MPLAB ICD 3在线调试器系统进行调试（设置断点和查看寄存器等），以下几  
个关键因素必须正确：

• 调试器必须连接到PC。必须由PC通过USB电缆对其供电，并且必须通过USB电
缆与MPLAB X IDE软件通信。更多详细信息，请参见第3.3节“常用调试功能”。

• 调试器必须如图2-6所示，通过模块化接口电缆（或同等规格的电缆）连接到目标器
件的VPP、PGC和PGD引脚。调试器和目标器件之间的VSS和VDD也需要分别连接
起来。

• 目标器件必须有电源和正常运行的振荡器。无论是什么原因使目标器件不工作，
MPLAB ICD 3在线调试器都不能进行调试。

• 必须对目标器件的配置字进行正确编程：

- 振荡器配置位应与RC和XT等相对应，具体取决于目标板的设计。

- 某些器件的看门狗定时器默认情况下是使能的，需要禁止。

- 不要使能目标器件的代码保护功能。

- 不要使能目标器件的表读保护功能。

- 对于某些带多个PGC/PGD对的器件，需要配置正确的PGC/PGD对。这仅针
对调试，因为编程可通过任意PGC/PGD对实现。

• 应禁止PGM（LVP）。

满足了以上条件后，即可接着进行下列操作：

• 进入调试模式的操作序列

• 调试详细信息

2.6.1 进入调试模式的操作序列

如果满足了调试要求，则在通过MPLAB X IDE菜单将MPLAB ICD 3在线调试器设置为    
当前工具（Edit>Project Properties，Advanced，MPLAB Environment（编辑>项目属  
性，高级，MPLAB环境））时，可以执行这些操作：

• 当选择了Debug>Debug Project（调试>调试项目）时，应用程序代码就会通过本 
章开始描述的 ICSP协议烧写到器件存储器。

• 一个小的“调试执行程序”将载入到目标器件程序存储器的高地址段。由于调试执
行程序必须驻留在程序存储器中，因此应用程序不能使用此保留的空间。有些器件
为调试执行程序提供了专门的存储区。详细信息请参见器件数据手册。

• MPLAB X IDE使能目标器件中的特殊“在线调试”寄存器。这使得调试执行程序  
能被调试器激活。关于器件保留资源的更多信息，请参见第2.8节“调试器使用的
资源”。

• 目标器件在调试模式下运行。
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2.6.2 调试详细信息

图2-7显示了准备好调试的MPLAB ICD 3在线调试器系统。

图2-7： 准备好调试的MPLAB® ICD 3在线调试器系统

一般情况下，为判断应用程序能否正确运行，可在程序代码中预先设置断点。当通过
MPLAB X IDE的用户界面设置断点时，断点的地址保存在目标器件的特殊内部调试寄  
存器中。PGC和PGD上的命令直接传送到这些寄存器来设置断点地址。

下一步，通常是在MPLAB X IDE中选择Debug>Debug Project功能。然后，调试器通   
知调试执行程序运行。目标器件从复位向量开始执行，直到程序计数器到达先前存储
在内部调试寄存器中的断点地址为止。

执行了断点地址处的指令之后，目标器件的在线调试机制就会启动，并将器件的程序
计数器值传递给调试执行程序（很像中断），用户的应用程序暂停执行。调试器通过
PGC和PGD与调试执行程序通信，获取断点状态信息，并将这些信息传送回MPLAB X 
IDE。MPLAB X IDE接着向调试器发送一系列查询以获取关于目标器件的信息，即文  
件寄存器内容和CPU状态。这些查询最终通过调试执行程序来执行。

调试执行程序像程序存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存
储临时变量。如果器件不工作，不管什么原因（如没有振荡器、电源连接故障及目标
板短路等），调试执行程序将无法与MPLAB ICD 3在线调试器通信，并且MPLAB X   
IDE会发出一条错误消息。

+5V

+12V

4.7 k

4.7 k

内部电路

程序
存储器

文件
寄存器

内部调试
寄存器

VPP/MCLR

PGC

PGD

1

5

4

执行程序
调试

调试执行程序

 

目标器件

为调试执行

VDD

调试执行程序

使用的空间

  

共用的硬件
堆栈

必须运行
才能使
调试执行
程序正常

程序保留的
空间

运行
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获取断点的另一种方式是选择Debug>Pause（调试>暂停）。这会翻转PGC和PGD
线，从而使目标器件的在线调试机制将程序计数器从程序存储器中的用户代码切换到
调试执行程序。同样，目标应用程序暂停，MPLAB X IDE通过调试器与调试执行程序  
的通信来查询目标器件的状态。

2.7 编程

使用MPLAB ICD 3作为编程器来编程实际（非-ICE/-ICD）器件，即不在调试头板上  
的器件。将MPLAB ICD 3在线调试器设置为当前工具（Edit>Project Properties，   
Advanced，MPLAB Environment）以执行这些操作：

• 当选择Run>Run Project（运行>运行项目）时，应用程序代码通过 ICSP协议编程 
到器件存储器。编程时不需要时钟，可以编程所有的处理器模式，包括代码保护、
使能看门狗定时器和表读保护。

• 一个小的“编程执行程序”程序将载入到某些目标器件程序存储器的高地址段。这
会增加大存储器器件的编程速度。

• 目标器件中的特殊“在线调试”寄存器及所有调试功能均通过MPLAB X IDE禁止。  
这意味着不能设置断点，不能查看或更改寄存器内容。

• 目标器件运行在发布模式下。作为编程器，调试器只能通过翻转MCLR线来复位和
启动目标器件。

2.8 调试器使用的资源

有关器件中调试器所用资源的完整列表，请参见MPLAB X IDE中MPLAB ICD 3在线调    
试器的在线帮助文件。在MPLAB X IDE 的Start Page 上，单击Release Notes and   
Support Documentation，然后单击Reserved Resources for MPLAB ICD 3（为MPLAB   
ICD 3保留的资源）链接。
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第3章 调试器使用
3.1 简介

以下主题介绍了如何安装和使用MPLAB ICD 3在线调试器。

• 安装和设置

• 常用调试功能

• 调试 /编程快速参考

• 调试器限制

• 连接目标

• 设置目标板

• 启动和停止调试

• 查看处理器存储器和文件

• 断点和跑表

3.2 安装和设置

关于安装 IDE和设置调试器以与 IDE配合使用的详细信息，请参见“Getting Started with  
MPLAB X IDE”帮助文件。

概述：

1. 安装MPLAB X IDE。

2. 将MPLAB ICD 3连接到PC，允许安装默认USB驱动程序。关于目标连接的更多  
信息，请参见第2章“工作原理”。

3. 安装开发时要使用的语言工具套件 /编译器。

4. 启动MPLAB X IDE。

5. 使用New Project（新建项目）向导（File>New Project（文件>新建项目））将  
“ICD 3”调试器添加到项目中。

6. 使用Project Properties对话框（File>Project Properties）设置选项。

7. 使用Project Properties对话框（File/Project Properties<Hardware Tool>（文件 /   
项目属性<硬件工具>））设置进行编程的工具选项。

8. 通过Run>Run Project运行项目（编译并运行）。

注意事项：

1. 每个调试器都包含一个惟一标识符，首次安装时，无论使用哪个计算机USB端口
都会由操作系统识别。

2. MPLAB X IDE操作在运行（运行或调试运行）时连接至硬件工具。为了始终连  
接到硬件工具（与MPLAB IDE v8中相同），请参见Tools>Options（工具>选项）  
中的Embedded（已安装工具）按钮，然后在Generic Settings（通用设置）选 
项卡中，选中Maintain active connection to hardware tool（保持与硬件工具的有     
效连接）复选框。

3. 配置位只能在Configuration Bits（配置位）窗口中查看。要在代码中设置配置位， 
选择Window>PIC Memory Views（窗口>PIC 存储器视图），然后从Memory  
（存储器）下拉列表中选择“Configuration Bits”，从Format（格式）下拉列表 
中选择“Read/Write”（读 /写）使能设置访问。

注： 调试器只能为目标板提供最高100 mA的电流。
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3.3 常用调试功能

关于调试功能的详细信息，请参见帮助文件“Getting Started with MPLAB X IDE”的    
“Debugging Code”（调试代码）部分。此部分包括：

1. 通过Debug>Debug Project调试运行项目（编译、编程并运行）

2. 使用断点

3. 单步执行代码

4. 使用Watches（观察）窗口

5. 查看存储器、变量和调用堆栈

6. 使用调用图

3.4 调试 /编程快速参考

下表给出了将MPLAB ICD 3在线调试器用作调试或编程工具时的快速参考。

3.5 调试器限制

有关器件的调试器限制的完整列表，请参见MPLAB X IDE中MPLAB ICD 3在线调试器    
的在线帮助文件。

3.6 连接目标

内置的连接允许选择与目标板之间通信的类型。更多详细信息和连接图，请参见第2.3节
“调试器与目标板之间的通信”。

1. 插入USB/电源电缆（如果尚未连接）。

2. 用通信电缆将调试器与目标板相连。

表3-1： 调试和编程操作

项目 调试 编程

所需硬件 PC和目标应用（Microchip演示板或您自己设计的电路板）。

调试器主机、USB电缆、通信驱动板和电缆。

带板上调试电路的器件或带特殊-ICE器件的调试头。 器件（带或不带板上调试电路）。

MPLAB X IDE选择 Project Properties，Hardware Tool选择 ICD 3。

Debug>Debug Run（调试>调试运行） Program Target Project（编程目标项目）工  
具栏按钮。

编程操作 将 应 用 程 序 代 码 烧 写 到 器 件 中。根 据 Project
Properties对话框上的选择，这可以是程序存储器的
任何范围。此外，还有一个小的调试执行程序位于
程序存储器中，其他调试资源保留。

将应用程序代码烧写到器件中。根据
Project Properties对话框上的选择，这可 
以是程序存储器的任何范围。

可用的调试功能 适用于器件的所有功能——断点和跟踪等 N/A

串行快速编程 
（Serial Quick-Time 
Programming，
SQTP）

N/A 使用MPLAB PM3生成SQTP文件。然后， 
使用 ICD3CMD烧写到器件。

命令行操作 N/A 使用ICD3CMD，默认路径为：C:\Program 
Files (x86)\Microchip\MPLABX\mplab_ipe。
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图3-1： 连接通信电缆和USB/电源电缆

3.7 设置目标板

必须为要使用的目标器件类型设置目标板。

3.7.1 使用生产器件

对于生产器件，调试器可直接连接到目标板。目标板上的器件必须有内置调试电路，
以便MPLAB ICD 3在线调试器使用它进行调试。要了解器件是否有必需的调试电路，  
即必须有一个“Background Debugger Enable”（后台调试器使能）配置位，请查阅  
器件数据手册。

目标板必须有一个连接器，以适合为调试器所选的通信方式。有关连接信息，请参见
第2.3节“调试器与目标板之间的通信”。

3.7.2 使用 ICE器件

对于 ICE器件，需要 ICE调试头板。调试头板包含仿真特定器件或器件系列所必需的
硬件。关于 ICE调试头的更多信息，请参见“Processor Extension Pak and Header    
Specification”（DS51292）。

将转换插座与ICE调试头一起使用，以将调试头连接到目标板。提供了多种类型的转换
插座，以允许通用的调试头能够与某个受支持的表面贴装类型相连。有关转换插座的
更多信息，请参见“Transition Socket Specification”（DS51194）。

调试头或处理器扩展套件的调试头板布线有所不同。有关连接信息，请参见第2.3节
“调试器与目标板之间的通信”。

USB /电源

来自PC

通信电缆

来自目标板

2

1
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3.7.3 为目标板供电

有多种配置可为MPLAB ICD 3和目标板供电。配置要点：

• 当使用USB连接时，MPLAB ICD 3可由PC供电，但它只能够在3V-5V的VDD下为  
较小的目标板提供最大100 mA的有限电流。

• 理想方法是由目标板提供 VDD，因为它可提供较宽的电压范围（2V-5V）。这样做
的另一个优点是可继承即插即用的目标检测功能，即当MPLAB X IDE检测到目标  
板和器件时，它将在Output（输出）窗口中通知您。

使用适当的电缆将MPLAB ICD 3连接到目标板（如果尚未连接）（见第3.6节“连接目  
标”）。然后为目标板供电。

3.8 启动和停止调试

要在MPLAB X IDE中调试应用程序，必须创建一个包含源代码的项目，以便按照如下  
所述编译代码、将代码烧写到器件中并执行：

• 选择Debug>Debug Project或从Run（运行）工具栏选择Debug Project以运行  
代码。

• 选择Debug>Pause或从Debug工具栏选择Pause以暂停代码。

• 选择Debug>Continue（调试>继续）或从Debug工具栏选择Continue以再次运行
代码。

• 选择Debug>Step Into（调试>单步进入）或从Debug工具栏选择Step Into以单步  
执行代码。注意不要单步进入Sleep指令，否则必须执行处理器复位以恢复仿真。

• 选择Debug>Step Over（调试>单步跳过）或从Debug工具栏选择Step Over以单  
步跳过某一代码行。

• 选择Debug>Finish Debugger Session（调试>完成调试器会话）或从Debug工具  
栏选择Finish Debugger Session以结束代码执行。

• 选择Debug>Reset（调试>复位）或从Debug工具栏选择Reset以对代码执行处理器
复位。根据器件的不同，可能有其他复位（如POR/BOR、MCLR和系统复位）。

3.9 查看处理器存储器和文件

MPLAB X IDE提供了多个窗口来查看调试信息和各处理器存储器信息，可在Window  
（窗口）菜单中进行选择。关于使用这些窗口的更多信息，请查看MPLAB X IDE在线  
帮助。

• Window>PIC Memory Views（窗口>PIC存储器视图）——查看数据（RAM）和  
代码（ROM）器件存储器。从RAM、闪存、特殊功能寄存器（Special Function 
Register，SFR）、CPU和配置位中进行选择。

• Window>Debugging（窗口>调试）——查看调试信息。从变量、观察、调用堆栈、
断点和跑表中进行选择。

注： 目标电压只用于为 ICSP接口的驱动电路供电；而不能为MPLAB ICD 3供电。  
MPLAB ICD 3系统的电源只能来自USB端口。
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要查看源代码，在Projects（项目）窗口中找到要查看的源代码文件并双击以在Files
（文件）窗口中打开。该窗口中的代码根据所选处理器和编译工具采用不同颜色标
识。要更改颜色标识的样式，在Tools>Options的Fonts & Colors（字体和颜色）中，  
选择Syntax（语法）选项卡。

关于编辑器的更多信息，请参见NetBeans帮助中的 IDE Basics>Basic File Features   
（IDE基础知识>基本文件特性）。

3.10 断点和跑表

使用断点在代码中的指定行处暂停代码执行。使用跑表和断点对代码执行进行计时。

• 断点资源

• 硬件或软件断点选择

• 断点和跑表的使用

3.10.1 断点资源

对于16位器件，断点、数据捕捉和运行时观察使用相同的资源。因此，可用的断点数
实际上是可用的断点 /触发组合数。

对于32位器件，断点使用的资源与数据捕捉和运行时观察不同。因此，可用的断点数
与可用的触发数无关。

可用和 /或已用的硬件和软件断点数在Dashboard（仪表板）（Window>Dashboard
（窗口>仪表板））窗口中显示。有关该功能的更多信息，请参见MPLAB X IDE文档。  
并非所有器件都有软件断点。

有关断点操作的限制（包括每个器件硬件断点的常规数目以及硬件断点skidding量），
请参见MPLAB X IDE的在线帮助文件了解有关MPLAB ICD 3在线调试器限制的信息。

3.10.2 硬件或软件断点选择

要选择硬件或软件断点：

1. 在Projects窗口中选择项目，然后，选择File>Project Properties；或右键单击项 
目并选择“Properties”。

2. 在Project Properties对话框的“Categories”（类别）下，选择“ICD3”。

3. 在“Option Categories”（选项类别）下，选择“Debug Options”（调试选项）。

4. 选中“Use software breakpoints”（使用软件断点）以使用软件断点。取消选  
中以使用硬件断点。

为帮助您确定使用哪类断点（硬件或软件），下表对每种断点的特性进行了比较。

注： 使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种
方式使用过的器件用作生产器件。
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表3-2： 硬件断点与软件断点

3.10.3 断点和跑表的使用

断点用于暂停代码的执行。要确定两个断点之间的时间，请使用跑表。

有关如何设置及使用断点和跑表的信息，请参见MPLAB X IDE在线帮助。

特性 硬件断点 软件断点

断点数 有限 无限

断点写入到* 内部调试寄存器 闪存程序存储器

断点应用于** 程序存储器 /数据存储器 仅程序存储器

设置断点的时间 最短 取决于振荡器速度、编程闪存
存储器的时间以及页大小

断点skidding 大多数器件。有关详细信息，请参
见在线帮助的“Limitations”（限
制）部分。

无

* 器件中写入断点信息的位置。
** 适用于断点的器件功能类型。这是设置断点的位置。
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第4章 故障诊断首要步骤
4.1 简介

如果MPLAB ICD 3在线调试器在工作过程中出现问题，请从此处开始故障诊断。

• 要首先回答的5个问题

• 无法调试的首要原因

• 需要考虑的其他事项

4.2 要首先回答的5个问题

1. 使用的是哪款器件？ 
要支持新的器件，通常要求将MPLAB X IDE升级到较新的版本。黄灯 = 未测试    
是否支持。

2. 您使用的是Microchip的演示板还是您自己设计的电路板？ 
您是否遵循了用于通信连接的电阻 /电容的准则？请参见第2章“工作原理”。

3. 您是否已为目标板供电？ 
调试器无法为目标板提供大于100 mA的电流。

4. 在安装过程中您是否使用了USB集线器？它是否已上电？ 
如果仍有问题，请尝试不使用集线器来连接调试器和PC，而是将调试器直接插
入PC。

5. 您是否使用了随调试器一起提供的标准通信电缆（RJ-11）？ 
如果您使用了更长的电缆，则可能导致通信错误。

4.3 无法调试的首要原因

1. 振荡器不工作。 
检查与振荡器有关的配置位设置。如果使用的是外部振荡器，请尝试使用内部振
荡器。如果使用的是内部PLL，请确保PLL的设置正确。

2. 目标板未上电。 
检查电源电缆连接。

3. VDD电压超出该器件规范。 
更多详细信息，请参见器件编程规范。

4. 调试器已断开与PC和 /或目标板的物理连接。 
检查通信电缆的连接。

5. 器件受到代码保护。检查配置位设置，看是否使能了代码保护。

6. 调试器与PC的通信已中断。 
在MPLAB X IDE中重新连接到调试器。
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7. 尝试调试的生产器件没有调试功能。  
请使用调试头代替。（请参见“推荐读物”中的“Processor Extension Pak and   
Debug Header Specification”。）

8. 目标应用程序损坏或包含错误。 
例如，项目中使用了常规链接描述文件，而不是调试器版本的链接描述文件（例
如，使用了18F8722.lkr，而不是18F8722i.lkr）。尝试重新编译和重新编程目标
应用程序。然后对目标器件启动上电复位。

9. 没有在配置位中编程正确的 PGC/PGD 引脚对（对于带多个 PGC/PGD 引脚对的
器件）。

10. 其他干扰调试的配置设置。 
任何阻止目标器件执行代码的配置设置同样会阻止调试器将代码置于调试模式。

11. 欠压检测电压大于工作电压VDD。 
这意味着器件处于复位状态，不能调试。

12. 没有遵循第2章“工作原理”中的通信连接准则。

13. 调试器无法始终执行请求的操作。 
例如，如果目标应用程序当前正在运行，则调试器无法设置断点。

4.4 需要考虑的其他事项

1. 该错误可能只发生一次。 
再次尝试操作。

2. 通常，编程可能会出现问题。 
作为测试，切换为运行模式，然后向目标器件烧写一个尽可能简单的应用程序
（例如，使LED闪烁的程序）。如果程序没有运行，则说明目标设置存在错误。

3. 目标器件很可能因某种原因（如过流）遭到损坏。 
开发环境明显对元器件不利。请考虑尝试另一个目标器件。

4. Microchip Technology Inc.提供了各种演示板来支持大部分单片机。请考虑使用  
这些已知正常工作的其中一个演示板来验证MPLAB ICD 3在线调试器的功能是否  
正常。或者，也可以使用环回测试板来验证调试器本身（第B.6节“ICD 3测试接 
口板”）。

5. 查看调试器操作以确保应用设置正确。 
更多信息，请参见第2章“工作原理”。

6. 如果问题依然存在，请联系Microchip Support。
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第5章 常见问题解答（FAQ）
5.1 简介

本章提供有关MPLAB ICD 3在线调试器系统的常见问题的解答。

• 工作原理

• 出现的问题

5.2 工作原理

• 芯片中的什么部件允许其与MPLAB ICD 3在线调试器通信？

MPLAB ICD 3在线调试器可通过 ICSP接口与闪存芯片通信。它使用位于测试存储  
区中的调试执行程序。

• 必须运行调试执行程序对处理器吞吐量会有什么影响？

运行模式下，调试执行程序并不运行，因此在运行代码时不会降低吞吐量，即调试
器不会占用目标器件的任何周期。

• MPLAB ICD 3在线调试器与其他在线仿真器 /调试器相比有何不同？

请参见第2.2节“工具比较”。

• MPLAB X IDE与MPLAB ICD 3在线调试器如何接口来实现比旧版调试器更多的    
功能？

MPLAB ICD 3在线调试器通过位于测试存储区中的调试执行程序进行通信。此调  
试执行程序经过简化，能够实现更高的通信效率。调试器包含FPGA、大型SRAM
缓冲区（1Mx8）和高速USB接口。程序存储器映像下载并包含到SRAM中，从而
加快编程速度。与器件在线调试器模块接口时，调试器中的FPGA用作加速器。

• 在传统调试器上，数据必须移出到总线上才能对该数据执行复杂触发。MPLAB
ICD 3在线调试器上是否也需要这样？例如，是否可以根据变为高电平的标志执行暂 
停操作？

传统调试器使用一个特殊的调试器芯片（-ME）进行监视。MPLAB ICD 3在线调试  
器没有-ME，因此没有要在外部监视的总线。MPLAB ICD 3在线调试器采用调试引  
擎的内置断点电路而不是外部断点，因此总线和断点逻辑在器件内部进行监视。

• MPLAB ICD 3在线调试器是否具有复杂断点？

有。您可以根据数据存储单元中的值来实现中断。如果在中断前有多个事件发生，
还可以设置顺序断点序列。但只能设置两个序列。此外，还可以设置AND条件以
及执行PASS计数。
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• 是否具有采用光电隔离或电气隔离的驱动板？

这些驱动板采用直流光电隔离，而不是交流光电隔离。不能对当前系统施加悬浮电
压或高电压（120V）。

• 标准电缆存在哪些限制？

标准ICSP RJ-11电缆不允许超过15 Mbps的时钟速度。dsPIC33F DSC在全速运行   
时会超出15 Mbps的限值。

• 这是否会降低程序的运行速度？

MPLAB ICD 3在线调试器不占用任何周期。数据输出由芯片中的状态机执行。

• 可以调试以任何速度运行的dsPIC DSC吗？

MPLAB ICD 3能够以器件数据手册中指定的任何器件速度进行调试。

• 引脚6（LVP引脚）具有什么功能？

引脚6保留用于LVP（Low-Voltage Programming，低电压编程）连接。
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5.3 出现的问题

• 编程器件后，执行校验失败。这是编程问题吗？

选择“Run”（Run>Run Project）时，器件将在编程后立即自动运行。因此，如 
果代码对闪存存储器进行了更改，校验可能会失败。要阻止代码在编程后立即运
行，请选择“Hold in Reset”（保持复位）。

• 我的PC进入掉电 /休眠模式，并且现在调试器无法工作。这是怎么回事？

长时间使用调试器时（尤其是用作调试器时），请确保在PC操作系统的“电源选
项”对话框窗口中禁止休眠模式。跳转到“休眠”选项卡，清除或取消选中“启用
休眠”复选框。这可确保保持所有USB子系统组件之间的所有通信。

• 我已将外设设置为暂停时不冻结，但它却突然发生冻结。这是怎么回事？

对于dsPIC30F/33F和PIC24F/H器件，外设控制寄存器中的一个保留位（通常为bit
14或bit 5）由调试器用作冻结位。如果您对整个寄存器执行过写操作，那么您可能 
改写了此位。（在调试模式下用户可访问此位。）

为避免上述问题，请只在应用程序中对想要更改的位执行写操作（通过BTS和
BTC），而不是对整个寄存器执行写操作（通过MOV）。

• 使用16位器件时，发生了意外复位。如何确定复位的原因？

考虑以下几个方面：

- 要确定复位源，请检查RCON寄存器。

- 在中断服务程序（Interrupt Service Routine，ISR）中处理陷阱 /中断。应包括   
trap.c样式的代码，即：

void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- 使用ASSERT。例如：ASSERT (IPL==7)
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第6章 错误消息
6.1 简介

MPLAB ICD 3在线调试器会产生各种不同的错误消息；其中一些错误消息比较特殊，  
一些是仅供参考的信息类消息，而其他的都可以用常规纠正措施解决。通常，请阅读
错误消息下面的所有指示信息。如果无法解决问题或者无指示信息，请参见以下章节。

• 特殊错误消息

• 常规纠正措施

• 信息类消息

6.2 特殊错误消息

6.2.1 调试器到目标器件的通信错误

Failed to send database（无法发送数据库）

如果收到这个错误：

1. 尝试重新下载。该错误可能只发生一次。

2. 尝试手动下载编号最高的.jam文件。

如果这些措施无法解决问题，请参见第6.3.2节“调试器到目标器件的通信错误纠正
措施”。

6.2.2 损坏 /过时安装错误

Failed to download firmware（无法下载固件）

如果存在Hex文件：

• 重新连接并重试。

• 如果无法解决问题，则表明该文件可能已损坏。重新安装MPLAB X IDE。

如果不存在Hex文件：

• 重新安装MPLAB X IDE。

Unable to download debug executive（无法下载调试执行程序）

如果尝试调试时收到此错误：

1. 取消将调试器选作调试工具。

2. 关闭项目，然后关闭MPLAB X IDE。

3. 重新启动MPLAB X IDE，然后重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

Unable to download program executive（无法下载编程执行程序）

如果尝试编程时收到此错误：

1. 取消将调试器选作编程器。

2. 关闭项目，然后关闭MPLAB X IDE。

3. 重新启动MPLAB X IDE，然后重新打开项目。
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4. 将调试器重新选作编程器并尝试重新编程目标器件。

如果这些措施无法解决问题，请参见第6.3.4节“安装损坏纠正措施”。

6.2.3 调试失败错误

The target device is not ready for debugging. Please check your configuration bit    
settings and program the device before proceeding.（目标器件未准备好调试。请    
检查配置位设置并编程器件，然后继续。）

当您尚未编程器件就尝试运行时将收到此消息。如果在编程器件后尝试运行时收到此
消息，或者在编程器件后立即收到此消息：

器件受到代码保护。

您尝试进行操作（读、编程、空白检查或校验）的器件受到代码保护，即，无法读或
修改代码。检查配置位设置，看是否使能了代码保护。

要禁止代码保护，请根据器件数据手册，在代码或Configuration Bits窗口中置1或清零 
相应的配置位。然后擦除并重新编程整个器件。

如果这些措施无法解决问题，请参见第6.3.2节“调试器到目标器件的通信错误纠正措
施”和第6.3.6节“调试失败纠正措施”。

6.2.4 其他错误

ICD 3 is busy. Please wait for the current operation to finish.（ICD 3忙。请等待当    
前操作完成。）

如果在尝试取消将调试器选作调试器或编程器时收到此错误：

1. 等待——使调试器有时间完成任何应用程序任务。然后重新尝试取消选择调试器。

2. 选择Halt（暂停）来停止所有运行中的应用程序。然后重新尝试取消选择调试器。

3. 将调试器从PC上拔下。然后重新尝试取消选择调试器。

4. 关闭MPLAB X IDE。
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6.3 常规纠正措施

以下常规纠正措施可解决您遇到的问题：

• 读 /写错误纠正措施

• 调试器到目标器件的通信错误纠正措施

• 调试器到PC的通信错误纠正措施

• 安装损坏纠正措施

• USB端口通信错误纠正措施

• 调试失败纠正措施

• 内部错误纠正措施

6.3.1 读 /写错误纠正措施

如果收到读或写错误：

1. 是否按下了Abort（中止）？此操作可能产生读 /写错误。

2. 重试操作。该错误可能只发生一次。

3. 确保目标器件已上电并且器件的电压正确。有关所需器件电压，请参见器件数据
手册。

4. 确保调试器到目标器件的连接正确（PGC和PGD已连接）。

5. 对于写错误，确保在Settings（设置）对话框的Program Memory（程序存储器） 
选项卡上选中“Erase all before Program”（编程之前全部擦除）。

6. 确保所使用的电缆的长度正确。

6.3.2 调试器到目标器件的通信错误纠正措施

MPLAB ICD 3在线调试器与目标器件互不同步。

1. 选择Reset，然后重试操作。

2. 确保所使用的电缆的长度正确。

6.3.3 调试器到PC的通信错误纠正措施

MPLAB ICD 3在线调试器与MPLAB X IDE互不同步。

1. 拔下调试器，然后重新插入。

2. 重新连接到调试器。

3. 重试操作。该错误可能只发生一次。

4. 所安装的MPLAB X IDE版本可能与MPLAB ICD 3在线调试器上加载的固件版本    
不一致。请按照第6.3.4节“安装损坏纠正措施”中所述的步骤进行操作。

5. PC USB端口可能存在问题。请参见第6.3.5节“USB端口通信错误纠正措施”。

6.3.4 安装损坏纠正措施

该问题很可能是由于MPLAB X IDE的安装不完整或者损坏引起的。

1. 卸载PC上所有版本的MPLAB X IDE。

2. 重新安装所需的MPLAB X IDE版本。

3. 如果问题依然存在，请联系Microchip Support。
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6.3.5 USB端口通信错误纠正措施

该问题很可能是由于通信端口错误或者不存在引起的。

1. 重新连接到MPLAB ICD 3在线调试器。

2. 确保调试器已物理连接到PC上适当的USB端口。

3. 确保在调试器设置中选择了适当的USB端口。

4. 确保USB端口未被其他器件使用。

5. 如果要使用USB集线器，请确保集线器已上电。

6. 确保已加载USB驱动程序。

6.3.6 调试失败纠正措施

MPLAB ICD 3在线调试器无法执行调试操作。引发此错误的原因很多。请参见第4章  
“故障诊断首要步骤”。

6.3.7 内部错误纠正措施

内部错误通常难以预料并且不应该发生。它们主要用于Microchip内部开发。

最可能的原因是安装损坏（第6.3.4节“安装损坏纠正措施”）。

另一个可能的原因是系统资源不足。

1. 尝试重新启动系统以释放存储器。

2. 确保硬盘上有适当的可用空间（而且不是过多的磁盘碎片）。

如果问题依然存在，请联系Microchip Support。

6.4 信息类消息

下面列出了MPLAB ICD 3在线调试器的信息类消息：

ICD3Info0001: ICD3 is functioning properly. If you are still having problems with    
your target circuit please check the Target Board Considerations section of the    
online help.（ICD3Info0001：ICD3正在正常工作。如果您的目标电路仍存在问题， 
请查阅在线帮助的“Target Board Considerations”（目标板注意事项）部分。）

请参见第B.7节“目标板注意事项”。
50002081B_CN 第40页  2015 Microchip Technology Inc.



用于MPLAB X IDE的  
®
MPLAB  ICD 3用户指南  

第7章 工程技术说明（ETN）
以下ETN与MPLAB ICD 3在线调试器相关。有关详细信息，请参见产品网页。

• ETN-29：适用于组装编号为10-00421-RC或更低的产品。
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附录A 调试器功能汇总
A.1 简介

下面列出了MPLAB ICD 3在线调试器功能的汇总。

• 调试器选择与切换

• 调试器选项选择

A.2 调试器选择与切换

使用Project Properties对话框可选择或切换项目的调试器。要进行切换，必须有多个 
MPLAB ICD 3与计算机相连。MPLAB X IDE将通过显示两个不同序列号来区分两个调    
试器。

要选择或更改项目使用的调试器：

1. 通过执行下列一项操作打开Project Properties对话框：

a) 单击Projects窗口中的项目名称并选择File>Project Properties。

b) 右键单击Projects窗口中的项目名称并选择“Properties”。

2. 在“Categories”下，单击“[[default]]”。

3. 在“Hardware Tools”（硬件工具）下，找到“ICD 3”并单击序列号（Serial  
Number，SN）来选择项目中使用的调试器。

A.3 调试器选项选择

在Project Properties对话框的调试器属性页面上设置调试器选项。

1. 通过执行下列一项操作打开Project Properties对话框：

a) 单击Projects窗口中的项目名称并选择File>Project Properties。

b) 右键单击Projects窗口中的项目名称并选择“Properties”。

2. 在“Categories”下，单击“ICD 3”。

3. 从“Options categories”（选项类别）中选择属性页面。单击某个选项可在下 
面的文本框中查看其说明。单击选项的右侧可对其进行更改。

可用的选项类别有：

• 要编程的存储器

• 固件

• 编程选项

• 调试选项

• 冻结外设

• 时钟

• 电源
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A.3.1 要编程的存储器

选择目标器件中要编程的存储器。

A.3.2 固件

选择并加载调试器固件。

A.3.3 编程选项

选择在编程之前擦除所有存储器或者合并代码。

表A-1： 要编程的存储器选项类别 
Auto select memories and 
ranges（自动选择存储器
和范围）

Allow ICD 3 to Select Memories（允许 ICD 3选择存储器）——      
调试器根据选择的器件和默认设置确定要编程的内容。
Manually select memories and ranges（手动选择存储器和范    
围）——选择要编程的存储器的类型和范围（见下文）。

Memory（存储器） 选中时可编程Memory，这里的Memory是存储器类型。类型包
括：EEPROM存储器、ID存储器、引导闪存和辅助存储器。

Program Memory
（程序存储器）

选中时可编程下面指定的目标程序存储器范围。

Program Memory Start (hex)
（程序存储器起始地址
（十六进制））
Program Memory End (hex)
（程序存储器结束地址
（十六进制））

程序存储器中要编程、读取或校验的范围的起始地址和结束地址
（以十六进制表示）。
如果接收到由于结束地址错误而产生的编程错误消息，则需要纠
正结束地址并重新编程。
注：地址范围不适用于擦除功能。执行擦除功能将擦除器件上的
所有数据。

Preserve Program Memory
（保留程序存储器）

选中时不会编程下面指定的目标程序存储器范围。

Preserve Program Memory 
Start (hex)
（保留程序存储器起始地址
（十六进制））
Preserve Program Memory 
End (hex)
（保留程序存储器结束地址
（十六进制））

编程、读取或校验时目标程序存储器中要保留的范围的起始地址
和结束地址（以十六进制表示）。
此存储器从目标程序存储器中读取且与现有的MPLAB X IDE存储  
器重叠。

Preserve Memory
（保留存储器）

若选中，则在编程时不会擦除Memory，这里的Memory是存储
器类型。类型包括：EEPROM存储器、ID存储器、引导闪存和
辅助存储器。

表A-2： 固件选项类别 
Use Latest Firmware
（使用最新固件）

选中时可使用最新固件。取消选中时则选择下面的固件版本。

Firmware File（固件文件） 单击右侧的文本框可搜索与调试器相关的固件文件（.jam）。

表A-3： 编程选项的选项类别 
Erase All Before Program 选中时可在开始编程之前擦除全部存储器。

除编程未用过的器件或已擦除的器件外，其余情况下都必须选中
此复选框。若未选中此复选框，将不对器件执行擦除操作并且程
序代码将与器件中已存在的代码合并。

Enable Low-Voltage 
Programming（使能低电
压编程）

仅用于Programmer Settings（编程器设置），PIC12F/16F1xxx 
器件：
如果LVP配置位设置为“Low-voltage programming enabled”  
（使能低电压编程），则可在高电压（默认）或低电压（在此处
使能）下编程。
如果LVP配置位设置为“High-voltage on MCLR/Vpp must be used     
for programming”（必须使用MCLR/Vpp上的高电压进行编程）， 
则只能在高电压下编程。
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A.3.4 调试选项

如果软件断点对项目器件可用，则使用软件断点。

A.3.5 冻结外设

选择在程序暂停时冻结或不冻结的外设。

PIC12/16/18 MCU器件

要在暂停时冻结/取消冻结所有器件外设，请选中 /取消选中Freeze on Halt（暂停时冻  
结）复选框。如果这并未使所需外设暂停，请注意，某些外设没有暂停时冻结功能，
因而无法受调试器控制。

dsPIC30F/33F、PIC24F/H和PIC32MX器件

对于“Peripherals to Freeze on Halt”（暂停时冻结的外设）列表中的外设，选中某个    
外设即可在暂停时将其冻结。取消选中外设可使其在程序暂停时运行。如果未在列表
中看到任何外设，则选中“All Other Peripherals”（所有其他外设）。如果这并未使  
所需外设暂停，请注意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

要选择包括“All Other Peripherals”在内的所有外设，则单击Check All（全部选中）。   
要取消选择包括“All Other Peripherals”在内的所有外设，则单击Uncheck All（全部   
取消选中）。

A.3.6 时钟

设置此选项可将内部快速RC时钟用于所选器件。

表A-4： 调试选项的选项类别 
Use Software 
Breakpoints
（使用软件断点）

选中时可使用软件断点。取消选中时则使用硬件断点。请参见以下讨论，
了解哪种类型最适合您的应用程序。

表A-5： 软件断点与硬件断点

特性 软件断点 硬件断点

断点数 无限 有限

断点写入到 程序存储器 调试寄存器

设置断点的时间 取决于振荡器速度——可能需
要数分钟

最短

Skidding 无 有

注：使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件
用作生产器件。

表A-6： 冻结外设的选项类别 
Freeze Peripherals
（冻结外设）

暂停时冻结所有外设。
此选项适用于PIC12/16/18 MCU。

Peripheral（外设） 暂停时冻结此外设。
此选项适用于16位和32位MCU。

表A-7： 时钟选项类别 
 Use FRC in debug mode     
（在调试模式下使用FRC）
（仅限dsPIC33F和
PIC24F/H器件）

调试时，使用器件内部快速RC（FRC）提供时钟，而不使用为应
用指定的振荡器。这在应用时钟比较慢时非常有用。
选中此复选框可让应用以低速运行，但以更快的FRC速度进行调试。
更改此设置后需重新编程。
注：未被冻结的外设将在调试时以FRC速度运行。
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A.3.7 电源

选择电源选项。

表A-8： 电源选项类别 
Power target circuit from ICD 3
（通过ICD 3为目标电路供电）

如果使能（选中）该选项，则将使能工具栏上的Power On/Off 
（上电 /断电）按钮。初始情况下为上电状态。每次单击该按
钮将切换到相反状态。上电状态下会切换为断电状态，断电
状态下则会切换为上电状态。如果禁止（取消选中）为目标
电路供电的设置，则Power On/Off按钮将恢复为禁止状态。
项目最后一次保存时的状态即为项目重新打开时的状态。

Voltage Level（电压大小） 如果选中上面的复选框，则可选择调试器提供的目标Vdd
（3.0V-3.5V）。
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附录B 硬件规范
B.1 简介

本章详述了MPLAB ICD 3在线调试器系统的硬件和电气规范。

B.2 重点

本章讨论了：

• USB端口 /电源

• MPLAB ICD 3在线调试器

• 标准通信硬件

• ICD 3测试接口板

• 目标板注意事项

B.3 USB端口 /电源

MPLAB ICD 3在线调试器通过与USB 2.0版本兼容的通用串行总线（Universal Serial    
Bus，USB）端口与主机PC连接。USB连接器位于调试器主机的侧面。

系统能够通过USB接口重载固件。

通过USB接口为系统供电。根据USB规范，该调试器被归类为高功耗系统，需要通过
USB提供300 mA的电流，以使该调试器能在所有工作模式（调试器/编程器）下正常 
工作。

电缆长度——在调试器工具包里随附了正常工作所需长度的PC至调试器电缆。

自供电的集线器——如果您想使用USB集线器，请确保它是自供电的。此外，PC键盘
上的USB端口不能为调试器正常工作提供足够的功率。

PC休眠 /掉电模式——禁止PC上的休眠或其他省电模式，以确保与调试器的正常USB
通信。

注： MPLAB ICD 3在线调试器通过其USB连接供电。目标板则由自身电源供电。  
另外，MPLAB ICD 3仅可在目标板消耗的电流小于100 mA的情况下为目标板   
供电。
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B.4 MPLAB ICD 3在线调试器

调试器包含封装在外壳中的主电路板，带有一个USB连接器和一个RJ-11连接器。调
试器外壳上有指示灯（LED）。

B.4.1 主电路板

该组件带有接口处理器（dsPIC DSC）、USB速度为480 Mbps的USB 2.0接口、用于常   
规系统控制和增加通信吞吐量的现场可编程门阵列（Field Programmable Gate Array，   
FPGA）、用于保持程序代码映像以将其烧写到仿真器件内部闪存中的SRAM以及LED
指示灯。

B.4.2 指示灯（LED）

指示灯具有如下含义。

LED 颜色 说明

电源 绿色 上电时点亮。

工作 蓝色 在刚上电或与目标板连接时点亮。

状态 绿色 在调试器正常工作（待机）时点亮。

红色 操作失败时点亮。

橙色 调试器忙时点亮。
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B.5 标准通信硬件

要使调试器与目标板之间进行标准通信（第2.3节“调试器与目标板之间的通信”），
应使用具有RJ-11连接器的适配器。

要在此类型的通信中使用调试头板，您需要一个针对器件的处理器套件，它包括一个
包含所需 ICE/ICD器件的8引脚连接器调试头板和一个标准适配器板。

更多关于调试头板的信息，请参见“Processor Extension Pak and Header Specification”    
（DS51292）。

B.5.1 标准通信

标准通信接口是与目标处理器的主要接口。它包含与高电压（VPP）和VDD检测线的连
接，以及烧写和连接目标器件所需的时钟和数据连接。

VPP高电压线可生成电压范围为0V至14V的可变电压，以满足特定仿真处理器的电压
要求。

VDD检测连接从目标处理器汲取极少的电流。实际功率来自MPLAB ICD 3在线调试器  
系统，因为VDD检测线仅用作参考来跟踪目标电压。VDD连接与光电开关隔离。

时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号处于高阻模式（即使在未向MPLAB ICD 3在线调试器系统施加电  
源时也是如此）

• 时钟和数据信号可免受因目标系统故障或连接不当引起的高电压的影响

• 时钟和数据信号可免受故障目标系统中的电气短路引起的大电流的影响

图B-1： 6引脚标准引脚排列

注： 以前的调试头板使用6引脚（RJ-11）连接器，而非8引脚连接器，所以这些
调试头可以直接连接到调试器。

表B-1： 电气逻辑表 (1)

逻辑输入 Vih = Vdd x 0.7V（最小值）

Vil = Vdd x 0.3V（最大值）

逻辑输出 Vdd = 5V Vdd = 3V Vdd = 2.3V Vdd = 1.65V

Voh = 3.8V
（最小值）

Voh = 2.4V
（最小值）

Voh = 1.9V
（最小值）

Voh = 1.2V
（最小值）

Vol = 0.55V
（最大值）

Vol = 0.55V
（最大值）

Vol = 0.3V
（最大值）

Vol = 0.45V
（最大值）

注 1： PGC/PGD负载——4.7 KΩ负载接地。

1

2

3

4

5

6

引脚 名称 功能

1 VPP 电源
2 VDD_TGT 目标板上的电源
3 GND 地
4 PGD（ICSPDAT） 标准通信数据
5 PGC（ICSPCLK） 标准通信时钟
6 PGM（LVP） 低电压编程

目标板

标准插座

的底部
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B.5.2 模块化电缆和连接器

在标准通信中使用模块化电缆连接调试器和目标应用。下面列出了有关电缆及其连接
器的规范。

B.5.2.1 模块化连接器规范

• 制造商，部件编号——AMP Incorporated，555165-1

• 代理商，部件编号——Digi-Key，A9031ND

下表显示了某个应用中的模块化连接器引脚与单片机引脚的对应关系。这种配置提供
了全部的 ICD功能。

图B-2： 目标板的模块化连接器引脚排列

B.5.2.2 模块化插头规范

• 制造商，部件编号——AMP Incorporated，5-554710-3

• 代理商，部件编号——Digi-Key，A9117ND

B.5.2.3 模块化电缆规范

制造商，部件编号——Microchip Technology，07-00024

图B-3： 模块化电缆

模块化连接器引脚 单片机引脚

6 PGM（LVP）

5 RB6

4 RB7

3 地

2 目标器件的VDD

1 VPP

1
6

目标板上模块化连接器引脚排列的
底视图

1 6

目标板上模块化连接器的
正视图

引脚 1

8.00‚

引脚 6
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硬件规范
B.6 ICD 3测试接口板

该板可用于验证调试器是否正常工作。要使用该板：

1. 将调试器从目标板和PC断开。

2. 通过模块化电缆将 ICD 3测试接口板连接到调试器。

图B-4： MPLAB ICD 3连接到测试接口板

3. 将调试器重新连接到PC。

4. 启动MPLAB X IDE。确保现有项目全部关闭。

5. 选择Debug>Run Debugger/Programmer Self Test（调试>运行调试器 /编程器自   
检），然后选择要测试的特定“ICD 3”并单击OK（确定）。

6. 确保 ICD 3测试接口板和电缆已连接。单击Yes（是）继续。

7. 在调试器的Output（输出）窗口中查看自检结果。如果测试成功运行，将显示以
下内容：

Test interface PGC clock line write succeeded.
Test interface PGD data line write succeeded.
Test interface PGC clock line read succeeded.
Test interface PGD data line read succeeded.
Test interface LVP control line test succeeded.
Test interface MCLR level test succeeded.
ICD3 is functioning properly. If you are still having problems with 
your target circuit please check the Target Board Considerations 
section of the online help.

8. 调试器通过自检后，请将 ICD 3测试接口板从调试器断开。

如果测试失败，请在http://support.microchip.com/上输入票证。将Output窗口的内容
复制并粘贴到问题说明中。

ICD 3测试接口板

来自PC的

模块化
电缆

MPLAB® ICD 3

USB/电源
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B.7 目标板注意事项

应根据所选器件（2.0V-5.5V）和应用的要求向目标板供电。

确保调试器确实检测到目标电源。Vdd_TGT上具有10 K负载。

根据使用的调试器 -目标板通信类型，目标板电路应考虑以下注意事项：

• 第2.4.2节“目标板连接电路”

• 第2.4.5节“影响调试器正常运行的电路”
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附录C 版本历史
版本A（2012年5月）

本文档的初始版本。

版本B（2014年9月）

• 重新整理了“调试器使用”部分。

• 更新了“推荐读物”部分。

• 修改了“故障诊断首要步骤”、“FAQ”和“错误消息”几章。

• 增加了“工程技术说明”一章。
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支持
有关支持问题，请参见此处讨论的各项。

• 保修登记

• Microchip网站

• 开发系统变更通知客户服务

• 客户支持

A.1 保修登记

请填写随附的保修登记卡 （Warranty Registration Card）并尽快寄出。寄出保修登记
卡的用户可收到新产品更新信息。可在 Microchip 网站上获得临时软件版本。

A.2 MICROCHIP网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的互联网浏览器即可访问，网站提供以下信息：

• 产品支持 —— 数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以
及硬件支持文档、最新的软件版本以及归档软件

• 一般技术支持 —— 常见问题解答 （FAQ）、技术支持请求、在线讨论组以及
Microchip 顾问计划成员名单

• Microchip 业务 —— 产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活
动安排表、 Microchip 销售办事处、代理商以及工厂代表列表

A.3 开发系统变更通知客户服务

Microchip 的客户通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在
他们感兴趣的某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

要注册，请先访问 Microchip 网站 www.microchip.com，点击 “变更通知客户”
（Customer Change Notification），然后按照注册指示完成注册。
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支持
在选择首选项时，选择“Development Systems”（开发系统）将会在列表中填入可
用的开发工具。下面列出了主要的工具类别：

• 编译器——Microchip C编译器、汇编器、链接器及其他语言工具的最新信息。包
括所有MPLAB C编译器、所有MPLAB汇编器（包括MPASM汇编器）、所有
MPLAB链接器（包括MPLINK目标链接器）以及所有MPLAB库管理器（包括
MPLIB目标库管理器）。

• 仿真器——Microchip在线仿真器的最新信息。其中包括MPLAB REAL ICE和
MPLAB ICE 2000在线仿真器。

• 在线调试器——Microchip在线调试器的最新信息。其中包括MPLAB ICD 2和
MPLAB ICD 3在线调试器以及PICkit 2 Debug Express和PICkit 3 Debug 
Express。

• MPLAB IDE——关于开发系统工具的Windows集成开发环境Microchip MPLAB 
IDE的最新信息，主要针对MPLAB IDE、MPLAB IDE项目管理器、MPLAB编辑
器、MPLAB SIM软件模拟器以及一般编辑和调试功能。

• 编程器——Microchip编程器的最新信息。其中包括器件（生产）编程器MPLAB 
REAL ICE在线仿真器、MPLAB ICD 3在线调试器、MPLAB PM3和PRO MATE 
II，以及开发（非生产）编程器MPLAB ICD 2在线调试器、PICSTART Plus和
PICkit 1、2和3。

• 入门 /演示板——包括MPLAB入门工具包电路板、PICDEM演示板以及各种其他
评估板。

A.4 客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）

• 技术支持

客户应联系其代理商、代表或应用工程师 （FAE）寻求支持。当地销售办事处也可为
客户提供帮助。本文档后附有销售办事处的联系方式。

也可通过 http://microchip.com/support 获得网上技术支持。

如果您发现本文档有任何错误或者对本文档有任何建议，请通过电子邮件联系我公司
TRC经理，电子邮件地址为CTRC@microchip.com。
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术语表
A
ANSI

美国国家标准学会，是美国负责制订和批准标准的组织。

ASCII

美国信息交换标准码是使用7个二进制位来表示每个字符的字符集编码。它包括大写和
小写字母、数字、符号以及控制字符。

B

八进制（Octal）

使用数字0-7，以8为基数的计数体制。最右边的位表示1的倍数，右边第二位表示8的
倍数，右边第三位表示82 = 64的倍数，以此类推。

本机数据大小（Native Data Size）

对于本机跟踪，Watches（观察）窗口中使用的变量长度必须与所选器件的数据存储
器长度相同：对于PIC18器件，为字节长度；对于16位器件，为字长度。

编译（Build）

编译并链接一个应用程序的所有源文件。

编译堆栈（Compiled Stack）

编译器管理的存储区域，静态分配变量的空间。当在目标器件上无法有效实现此类机
制时，编译堆栈将替代软件或硬件堆栈。

编译器（Compiler）

将用高级语言编写的源文件翻译成机器码的程序。

标识符（Identifier）

函数名或变量名。

表达式（Expression）

被算术或逻辑操作符分隔开的常量和 /或符号的组合。

C
C/C++

C语言是具有表达式简练、现代控制流程和数据结构，以及操作符丰富等特点的通用编
程语言。C++是C语言的面向对象版本。

COFF

公共目标文件格式。此格式的目标文件包含机器码、调试信息和其他信息。
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术语表
CPU

参见中央处理单元。

操作码（Opcode）

操作码。请参见助记符。

插件（Plug-in）

MPLAB IDE/MPLAB X IDE具有内置组件和插件模块，用于针对各种软件和硬件工具来   
配置系统。可在Tools（工具）菜单下找到几个插件工具。

程序存储器（Program Memory）

MPLAB IDE/MPLAB X IDE——器件中存储指令的存储区。也指仿真器或软件模拟器中   
包含已下载的目标应用固件的存储器。

MPLAB XC16汇编器 /编译器——器件中存储指令的存储区。

程序计数器（Program Counter）

包含正在执行指令的地址的存储单元。

程序计数器单元（Program Counter Unit）

MPLAB XC16汇编器——程序存储器布局的概念化表示。对于每个指令字，程序计数 
器递增2。在可执行段中，2个程序计数器单元等同于3个字节。在只读段中，2个程序
计数器单元等同于2个字节。

持久性数据（Persistent Data）

永不清除或初始化的数据。其目的是使应用程序可以在器件复位时保存数据。

重定位（Relocation）

链接器执行的过程，其中会将绝对地址分配给可重定位段，并且可重定位段中的所有
符号都会更新为相应的最新地址。

触发输出（Trigger Output）

指可在任意地址或地址范围产生的仿真器输出信号，与跟踪和断点的设置无关。可设
置任意个触发输出点。

次数计数器（Pass Counter）

每次发生一个事件（如执行特定地址处的一条指令）时都会递减1的计数器。当次数计
数器的值为零时，事件满足。可将次数计数器分配给中断和跟踪逻辑，以及在complex
trigger（复杂触发）对话框中的任何连续事件。

存储类别（Storage Class）

确定与已标识对象相关的存储器的使用寿命。

存储器模型（Memory Model）

对于C编译器，为应用程序可使用的存储区的表示。对于PIC18 C编译器，为一种描 
述，指定指向程序存储器的指针的长度。

存储限定符（Storage Qualifier）

指示被声明的对象的特殊属性（例如const）。

错误 /错误文件（Error/Error File）

错误报告使程序不能继续处理的问题。而且，当问题比较明显时，错误还尽可能标识
出源文件名和行号。错误文件包含由语言工具生成的错误消息和诊断信息。
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D
DWARF

使用任意记录格式调试。DWARF是用于ELF文件的调试信息格式。

带序列号的快速批量编程（Serialized Quick Turn Programming）

序列化允许您利用器件编程器将序列号编程到每个单片机器件中。该序列号可用作入
口代码、密码或 ID编号。

单步进入（Step Into）

这一命令与Single Step相同。Step Into（与Step Over相对）在CALL指令后，单步执   
行子程序。

单步跳出（Step Out）

Step Out允许跳出当前正在执行的子程序。此命令执行子程序中剩下的代码，然后在 
子程序的返回地址处停止执行。

单步跳过（Step Over）

Step Over允许单步调试代码而不单步执行子程序。当单步跳过一条CALL指令时，下一 
个断点将设置在CALL指令后的下一条指令处。如果由于某种原因，子程序陷入无限循
环或不正确返回，下一个断点将永远执行不到。除对CALL指令的处理不同外，Step
Over命令和Single Step相同。

单步执行（Single Step）

这一命令单步执行代码，一次执行一条指令。执行每条指令后，MPLAB IDE/MPLAB 
X IDE更新寄存器窗口、观察变量及状态显示，使您可分析和调试指令。也可单步执行 
C编译器源代码，但不是每次执行一条指令，MPLAB IDE/MPLAB X IDE将执行一行高   
级C语句生成的所有汇编指令。

单片机（Microcontroller）

高度集成的芯片，它包括CPU、RAM、程序存储器、I/O端口和定时器。

单片机模式（Microcontroller Mode）

PIC18单片机的一种程序存储器配置。在单片机模式下，仅允许内部执行。因此，在单
片机模式下仅可使用片内程序存储器。

导出（Export）

以标准的格式将数据发送出MPLAB IDE/MPLAB X IDE。

导入（Import）

从外面的源（如hex文件）将数据送入MPLAB IDE/MPLAB X IDE。

递归（Recursion）

已定义的函数或宏可调用自身的概念。编写递归宏时要特别小心；当递归没有出口时
容易陷入无限循环。

递归调用（Recursive Call）

直接或间接调用自身的函数。

地址（Address）

标识存储器中位置的值。
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术语表
堆（Heap）

用于动态存储器分配的存储区，其中的存储器块按运行时确定的任意顺序进行分配和
释放。

段（Section）

OCG psect的GCC等效形式。被链接器视为整体的代码或数据块。

段属性（Section Attribute）

属于段的GCC特性（如，access段）。

断点（Breakpoint）

硬件断点：一个事件，执行这种事件会导致暂停。

软件断点：一个地址，固件会在这个地址处暂停执行。通常由特殊的break指令获得。

断点逻辑与（ANDed Breakpoint）

为中断设置逻辑与条件，即只有断点1和断点2同时出现时，才会暂停程序。只有数据
断点和程序存储器断点同时出现时，才会完成此操作。

堆栈，编译（Stack, Compiled）

编译器管理和分配的存储区域，静态分配变量的空间。当在目标器件上无法高效实现
此类机制时，编译堆栈将替代软件堆栈。它阻止可重入。

堆栈，软件（Stack, Software）

应用程序用来存储返回地址、函数参数和局部变量的存储区。该存储区由程序中的指
令在运行时动态分配。它支持可重入函数调用。

堆栈，硬件（Stack, Hardware）

调用函数时，PIC单片机中存储返回地址的存储单元。

E
EEPROM

电可擦除的可编程只读存储器。一种可电擦除的特殊类型PROM。一次写或擦除一个
字节。EEPROM即使电源关闭时也能保留内容。

ELF

可执行链接格式。这种格式的目标文件包含机器码。调试和其他信息使用DWARF指
定。ELF/DWARF可提供优于COFF的优化代码调试。

Epilogue

编译器生成代码的一部分，负责释放堆栈空间、恢复寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。此代码在给定函数的任何用户代码之后、在函数
返回之前执行。

EPROM

可擦除的可编程只读存储器。通常通过紫外线照射来擦除的可编程只读存储器。

二进制（Binary）

使用数字0和1，以2为基数的计数体制。最右边的位表示1的倍数，右边第二位表示2
的倍数，右边第三位表示22 = 4的倍数，以此类推。
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F
FNOP

强制空操作。强制NOP周期是双周期指令的第二个周期。由于PIC单片机的架构是流
水线型，在执行当前指令的同时预取物理地址空间中的下一条指令。但是，如果当前
指令改变了程序计数器，那么这条预取的指令会被忽略，导致一个强制NOP周期。

Free-Standing

一种接受任何不使用复杂类型的严格符合程序的实现，而且在这种实现中，对库条款
（ANSI 89标准条款第7条）中规定的特性的使用，仅限于标准头文件<float.h>、 
<iso646.h>、<limits.h>、<stdarg.h>、<stdbool.h>、<stddef.h> 和
<stdint.h>的内容。

访问入口点（Access Entry Points）

访问入口点提供了一种方法，可跨段将控制转移到某个可能未在链接时定义的函数。
它们支持单独链接引导应用程序段和安全应用程序段。

仿真 /仿真器（Emulation/Emulator）

请参见 ICE/ICD。

非扩展模式（Non-Extended Mode）（PIC18 MCU）

在非扩展模式下，编译器不使用扩展指令，也不使用立即数偏移量变址寻址。

非实时（Non Real-Time）

指处理器处于断点或正在单步执行指令或者MPLAB IDE/MPLAB X IDE正运行在软件模   
拟器模式下。

非易失性存储器（Non-Volatile Storage）

关断电源后，能保存自身内容的存储器件。

符号（Symbol）

符号是描述组成程序的各个部分的通用机制。这些部分包括函数名、变量名、段名、
文件名、结构 /枚举 /联合标记名等。MPLAB IDE/MPLAB X IDE中的符号主要指变量   
名、函数名和汇编标号。链接后符号的值就是其在存储器中的值。

符号，绝对（Symbol, Absolute）

表示一个立即数的值，例如通过汇编.equ伪指令指定的定义。

G
GPR

通用寄存器。器件数据存储器（RAM）的一部分，作为一般用途。

概要文件（Profile）

对于MPLAB SIM软件模拟器，该文件是对寄存器执行的激励的汇总列表。

高级语言（High Level Language）

编写程序的语言，它比汇编语言更不依赖于具体的处理器。
DS50002081B_CN 第60页  2015 Microchip Technology Inc.



术语表
跟踪（Trace）

记录程序执行的仿真器或软件模拟器功能。仿真器将程序执行记录到其跟踪缓冲区
内，并可上载到MPLAB IDE/MPLAB X IDE的跟踪窗口中。

跟踪存储区（Trace Memory）

跟踪存储区包含在仿真器内部。跟踪存储区有时称为跟踪缓冲区。

跟踪宏（Trace Macro）

一个通过仿真器数据来提供跟踪信息的宏。由于该宏属于软件跟踪，所以必须将它添
加到代码中、必须重新编译或重新汇编代码，并且必须使用该代码对目标器件进行编
程，之后跟踪才会工作。

工具栏（Tool Bar）

一行或一列图标，单击这些图标时将执行MPLAB IDE/MPLAB X IDE功能。

工作簿（Workbook）

对于MPLAB SIM模拟器，是一种用于产生SCL激励的设置。

观察变量（Watch Variable）

调试会话期间可在Watches窗口中监控的变量。

归档 /归档器（Archive/Archiver）

归档/库是可重定位目标模块的集合。由将多个源文件汇编/编译为目标文件，然后使用
归档器 /库将目标文件组合为一个归档 /库文件生成。可将归档 /库与目标模块和其他归
档 /库链接，生成可执行代码。

国际标准化组织（International Organization for Standardization）

制订多行业和技术（包括计算和通讯）方面的标准的一个组织。也称为 ISO。

过滤器（Filter）

通过选择确定在跟踪显示或数据文件中包含 /排除哪些数据。

H

Hex代码 /Hex文件（Hex Code/Hex File）

Hex代码是以十六进制格式代码存储的可执行指令。Hex代码包含在hex文件中。

宏（Macro）

宏指令。宏指令是以缩写形式表示指令序列的指令。

宏伪指令（Macro Directive）

控制宏定义体中执行和数据分配的伪指令。

环回测试板（Loop-Back Test Board）

用于测试MPLAB REAL ICE在线仿真器的功能。

环境（Environment）

MPLAB PM3——包含关于如何编程器件的文件的文件夹。该文件夹可转移到SD/MMC 
卡。

汇编语言 /汇编器（Assembly/Assembler）

汇编语言是以符号形式描述二进制机器码的编程语言。汇编器是将汇编源代码翻译成
机器码的语言工具。
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I
ICE/ICD

在线仿真器 /在线调试器：用于对目标器件进行调试和编程的硬件工具。仿真器具有比
调试器更多的功能，例如跟踪。

在线仿真 /在线调试：使用在线仿真器或调试器进行仿真或调试的行为。

-ICE/-ICD：带有在线仿真或调试电路的器件（MCU或DSC）。该器件总是安装在调试
头板上，并用于通过在线仿真器或调试器进行调试。

ICSP

在线串行编程。一种通过使用串行通信并使用最少数量的器件引脚对Microchip嵌入式
器件编程的方法。

IDE

集成开发环境，如MPLAB IDE/MPLAB X IDE。

IEEE

电气与电子工程师协会。

J

机器码（Machine Code）

处理器实际读和解释的计算机程序的表示。二进制机器码程序由一系列机器指令（可能
还包含数据）组成。某个特定处理器的所有可用指令的集合称为它的“指令集”。

机器语言（Machine Language）

特定中央处理单元的指令集，不需翻译即可用于处理器。

基数（Radix）

数字基，十六进制或十进制，用于指定一个地址。

激励（Stimulus）

软件模拟器的输入（即为模拟对外部信号的响应而生成的数据）。通常数据采用文本
文件中一系列动作的形式。激励可以是异步的，同步的（引脚），时钟激励或寄存器
激励。

交叉引用文件（Cross Reference File）

引用符号表的一个文件及引用符号的文件的列表。如果定义了符号，则在列出的第一
个文件中包含符号的定义。其他文件包含对符号的引用。

校准存储区（Calibration Memory）

用来保存PIC单片机内置RC振荡器或其他器件外设的校准值的特殊功能寄存器或通用
寄存器。

节点（Node）

MPLAB IDE/MPLAB X IDE项目组件。

警告（Warning）

MPLAB IDE/MPLAB X IDE——提供警告，警告您发生了可能导致器件、软件文件或设   
备物理损坏的情况。

MPLAB XC16汇编器 /编译器——警告报告可能发生问题的情况，但并不暂停处理。
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静态RAM或SRAM（Static RAM or SRAM）

静态随机访问存储器。目标板上可读 /写且无需经常刷新的程序存储器。

局部标号（Local Label）

用LOCAL伪指令在一个宏内部定义的局部标号。这些标号特定于宏实例化的一个给定
实例。也就是说，声明为 local的符号和标号在遇到ENDM宏后不再可访问。

绝对变量 /函数（Absolute Variable/Function）

使用OCG编译器的@ address语法放置在绝对地址的变量或函数。

绝对段（Absolute Section）

具有链接器不能更改的固定（绝对）地址的GCC编译器段。

K

看门狗定时器（Watchdog Timer，WDT）

PIC单片机上在一段可选的时间长度后复位处理器的定时器。使用配置位来使能、禁止
和设置WDT。

可重定位（Relocatable）

地址未分配到存储器中固定位置的对象。

可重定位段（Relocatable Section）

MPLAB XC16汇编器——地址不固定（绝对）的段。链接器通过一个称为重定位的过 
程来为可重定位段分配地址。

可重入函数（Reentrant）

可以有多个同时运行的实例的函数。下面两种情况下可能发生函数重入： 直接或间接 
递归调用函数；或者在中断处理期间执行此函数。

可执行代码（Executable Code）

可装入来执行的软件。

控制伪指令（Control Directive）

汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

库 /库管理器（Library/Librarian）

参见归档 /归档器。

快速存取存储区（Access Memory）

仅限PIC18——PIC18器件中的一些特殊寄存器，对这些寄存器的访问与存储区选择寄
存器（Bank Select Register，BSR）的设置无关。

扩展单片机模式（Extended Microcontroller Mode）

在扩展单片机模式下，既可使用片内程序存储器，也可使用外部存储器。如果程序存
储器地址大于PIC18器件的内部存储空间，执行自动切换到外部存储器。

扩展模式（Extended Mode）（PIC18 MCU）

在扩展模式下，编译器将使用扩展指令（即ADDFSR、ADDULNK、CALLW、MOVSF、
MOVSS、PUSHL、SUBFSR和SUBULNK）以及立即数变址寻址。
 2015 Microchip Technology Inc. DS50002081B_CN 第63页



用于MPLAB X IDE的MPLAB® ICD 3用户指南
L
LVDS

低压差分信号传输。一种通过铜线进行高速（每秒千兆位）数据传输的低噪声、低功
耗和低幅值方法。

对于标准 I/O信号，数据存储取决于实际电压大小。电压大小可能受到传输线长度的影
响（线路越长，电阻就越高，这会使电压下降）。但对于LVDS，数据存储仅通过正负
电压值区分，而不是实际电压大小。因此，数据可以传输更长的线路距离，同时保持
干净、一致的数据流。

来源：http://www.webopedia.com/TERM/L/LVDS.html

链接描述文件（Linker Script File）

链接描述文件是链接器的命令文件。它们定义链接器选项并描述目标平台上的可用存
储器。

链接器（Linker）

把目标文件和库文件组合起来生成可执行代码并解析一个模块对另外一个模块引用的
语言工具。

列表伪指令（Listing Directive）

列表伪指令是控制汇编器列表文件格式的伪指令。它们允许指定标题、分页及其他列
表控制。

列表文件（Listing File）

列表文件是列出为每条C源语句生成的机器码，源文件中遇到的汇编指令、汇编器伪指
令或宏的ASCII文本文件。

逻辑探头（Logic Probe）

Microchip的某些仿真器最多可连接14个逻辑探头。逻辑探头提供外部跟踪输入、触发
输出信号、+5V和公共接地端。

M
Makefile

包含用于Make项目的指令的文件。使用该文件可以在MPLAB IDE/MPLAB X IDE之外   
使用make Make项目。

Make项目（Make Project）

重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU

单片机。microcontroller的缩写形式。也写作uC。

MPASM™汇编器（MPASM™ Assembler）

Microchip Technology用于PIC单片机、KeeLoq®器件和Microchip存储器件的可重定位 
宏汇编器。
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MPLAB ICD

Microchip的在线调试器，与MPLAB IDE/MPLAB X IDE配合使用。请参见 ICE/ICD。

MPLAB IDE/MPLAB X IDE

Microchip的集成开发环境。MPLAB IDE/MPLAB X IDE附带有编辑器、项目管理器和   
软件模拟器。

MPLAB PM3

Microchip的器件编程器。用于对PIC18单片机和dsPIC数字信号控制器进行编程。可与
MPLAB IDE/MPLAB X IDE配合使用或独立使用。代替PRO MATE II。

MPLAB REAL ICE™在线仿真器（MPLAB REAL ICE™ In-Circuit Emulator）

Microchip的新一代在线仿真器，与MPLAB IDE/MPLAB X IDE配合使用。请参见   
ICE/ICD。

MPLAB SIM

Microchip的软件模拟器，可与MPLAB IDE/MPLAB X IDE配合使用，支持PIC MCU和    
dsPIC DSC器件。

MPLIB™目标库管理器（MPLIB™ Object Librarian）

Microchip的库管理器，可与MPLAB IDE/MPLAB X IDE配合使用。MPLAB库管理器是   
用于将由MPASM汇编器（mpasm或mpasmwin v2.0）或MPLAB C18 C编译器生成的   
COFF目标模块组合成库文件的目标库管理器。

MPLINK™目标链接器（MPLINK™ Object Linker）

MPLINK链接器是Microchip MPASM汇编器和Microchip C18 C编译器的目标链接器。   
MPLINK链接器还可以与Microchip MPLIB库管理器配合使用。MPLINK链接器设计为 
在MPLAB IDE/MPLAB X IDE中使用，但是并不一定要在MPLAB IDE/MPLAB X IDE中     
使用它。

MRU

最近使用过的。指可从MPLAB IDE/MPLAB X IDE主下拉菜单中选择的文件和窗口。

命令行接口（Command Line Interface）

程序及其用户之间的一种完全基于文本输入和输出的通信手段。

模块（Module）

执行预处理器伪指令后，源文件的预处理输出。也称为编译单元。

模板（Template）

为以后插入自己的文件中使用而创建的文本行。MPLAB编辑器将模板存储到模板文
件中。

目标（Target）

指用户硬件。

目标板（Target Board）

构成目标应用的电路和可编程器件。
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目标处理器（Target Processor）

目标应用板上的单片机。

目标代码 /目标文件（Object Code/Object File）

目标代码是由汇编器或编译器生成的机器码。目标文件为包含机器码（可能还有调试
信息）的文件。它可以直接执行，或为可重定位的，需要与其他目标文件（如库文
件）链接，以生成完整的可执行程序。

目标文件伪指令（Object File Directives）

仅当创建目标文件时使用的伪指令。

目标应用程序（Target Application）

目标板上的软件。

N
NOP

空操作。除了让程序计数器加1外，没有其他作用的指令。

内部链接（Internal Linkage）

如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

匿名结构（Anonymous Structure）

MPLAB XC16 C编译器——未命名的结构。

MPLAB XC8 C编译器——属于C联合成员的未命名结构。匿名结构的成员可以像外围  
联合的成员一样进行访问。例如，在以下代码中，hi和lo是联合caster中的匿名结
构的成员。

union castaway
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;

O
OTP

一次性编程。非窗口封装的EPROM器件。由于EPROM需要紫外线照射来擦除其存储
内容，因此只有窗口片是可擦除的。

P
PC

个人计算机或程序计数器。

PC主机（PC Host）

任何运行支持的Windows操作系统的PC。

PIC MCU

PIC单片机（MCU）指Microchip的所有单片机系列。
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PICkit 2和3

Microchip的器件开发编程器，通过Debug Express实现调试功能。要了解支持哪些器 
件，请参见各工具的自述文件。

Pragma伪指令（Pragma）

对特定编译器有意义的伪指令。通常一条pragma伪指令用于向编译器传达实现定义的
信息。

Psect

GCC段的OCG等效形式，程序段的简称。被链接器视为整体的代码或数据块。

PWM信号（PWM Signal）

脉冲宽度调制信号。某些PIC MCU器件具有PWM外设。

跑表（Stopwatch）

测量执行周期的计数器。

配置位（Configuration Bit）

可对其编程来设置PIC MCU或dsPIC DSC工作模式的专用位。配置位可或不可再编程。

片外存储器（Off-Chip Memory）

片外存储器指PIC18器件的一种存储器选择，这种情况下存储器可位于目标板上，或所
有程序存储器都由仿真器提供。通过Options>Development Mode（选项>开发模式） 
访问Memory（存储器）选项卡可打开Off-Chip Memory selection（片外存储器选择）  
对话框。

Q

弃用功能（Deprecated Feature）

由于历史原因仍然支持但最终将逐步淘汰且不再使用的功能。

器件编程器（Device Programmer）

用于对电可编程半导体器件（如单片机）进行编程的工具。

嵌套深度（Nesting Depth）

一个宏可以包含其他宏的最大层数。

清除（Clean）

清除操作删除活动项目的所有中间项目文件，例如目标文件、hex文件和调试文件。项
目编译时会通过其他文件重新创建这些文件。

情形（Scenario）

对于MPLAB SIM软件模拟器，是一种用于激励控制的特定设置。
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R
RAM

随机访问存储器（数据存储器）。可以任意顺序访问其中信息的存储器。

ROM

只读存储器（程序存储器）。不能修改的存储器。

软件模拟器（Simulator）

模拟器件操作的软件程序。

S
Shell

MPASM汇编器shell是宏汇编器的提示性输入接口。有两个MPASM汇编器shell：一个
针对DOS版本，一个针对Windows操作系统版本。

Skew

不同时间出现在处理器总线上与指令执行有关的信息。例如，执行前一条指令的过程
中取指时，被执行的操作码出现在总线上；当实际执行该操作码时，源数据地址及其
值以及目标数据地址出现在总线上。当执行下一条指令时，目标数据值出现在总线
上。跟踪缓冲区一次捕捉总线上的这些信息。因此，跟踪缓冲区的一条记录将包含三
条指令的执行信息。执行一条指令时，从一条信息到另一条信息的捕捉周期数称为
skew。

Skid

当使用硬件断点来暂停处理器时，在处理器暂停前可能再执行一条或多条额外的指
令。在预期断点之后执行的额外指令数称为skid。

SQTP

参见带序列号的快速批量编程。

三字母词（Trigraph）

由三个字符组成的序列，均以??开头，由 ISO C定义用于替代单个字符。

闪存（Flash）

按块（而不是按字节）写或擦除数据的一种EEPROM。

上电复位仿真（Power-on-Reset Emulation）

在应用刚上电时，将随机值写到数据RAM区中来模拟RAM中未初始化值的软件随机
过程。

上载（Upload）

上载功能将数据从一个工具（如仿真器或编程器）传送到主机PC，或将数据从目标板
传送到仿真器。
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生产编程器（Production Programmer）

生产编程器是一种编程工具，其中设计了可对器件进行快速编程的资源。它具有在各
种电压下进行编程的能力并完全符合编程规范。在生产环境中，应用电路需要在组装
线上传送，时间是极其重要的，所以尽可能快地对器件编程至关重要。

十六进制（Hexadecimal）

使用数字0-9以及字母A-F（或a-f），以16为基数的计数体制。字母A-F表示（十进制
中）值为10-15的十六进制数。最右边的位表示1的倍数，右侧第二位表示16的倍数，
右侧第三位表示162 = 256的倍数，以此类推。

实时（Real Time）

当在线仿真器或调试器从暂停状态释放时，处理器将在实时模式下运行并且完全像正
常芯片那样工作。在实时模式下，仿真器的实时跟踪缓冲区被使能并不断捕获所有选
定的周期，同时所有中断逻辑也被使能。在在线仿真器或调试器中，处理器将实时执
行，直到有效断点导致暂停，或者直到用户暂停仿真器。

对于软件模拟器，实时仅意味着单片机指令的执行速度与主机CPU模拟这些指令的速
度相同。

事件（Event）

对可能包含地址、数据、次数计数、外部输入、周期类型（如取指和读 /写）及时间标
记的总线周期的描述。事件用于描述触发、断点和中断。

书签（Bookmark）

使用书签可以轻松定位到文件中的特定行。

在Editor（编辑器）工具栏中，选择Toggle Bookmarks（切换书签）添加 /删除书签。 
单击该工具栏上的其他图标以移动到下一个书签或上一个书签。

舒缓（Relaxation）

将某一指令转换为功能相同但大小较小的指令的过程。这对于节省代码长度非常有
用。MPLAB XC16目前知道如何将CALL指令放宽（relax）为RCALL指令。当被调用 
的符号处于当前指令的+/- 32k指令字范围内时，将会执行该操作。

属性（Attribute）

C程序中变量或函数的GCC特性，用于描述特定于机器的性质。

属性，段（Attribute, Section）

段的GCC特性，如“可执行”、“只读”或“数据”，它们可在汇编器.section伪
指令中指定为标志。

数据存储器（Data Memory）

在Microchip MCU和DSC器件中，数据存储器（RAM）由通用寄存器（General Purpose  
Register，GPR）和特殊功能寄存器（Special Function Register，SFR）组成。某些  
器件还有EEPROM数据存储器。

数据监视和控制界面（Data Monitor and Control Interface，DMCI）

数据监视和控制界面或DMCI是MPLAB X IDE中的一个工具。此界面提供对项目中应用  
程序变量的动态输入控制。可使用4个动态分配的图形窗口中的任一个以图形形式查看
应用程序生成的数据。
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数据伪指令（Data Directive）

数据伪指令是那些控制汇编器对程序存储器或数据存储器进行分配的指示性语句，它
提供了用符号（即有意义的名称）引用数据项的方法。

数字信号处理 /数字信号处理器（Digital Signal Processing\Digital Signal 
Processor）

数字信号处理（Digital signal processing，DSP）是对数字信号（通常为已转换为数字  
形式（经过采样）的模拟信号（声音或图像））的计算机处理。数字信号处理器是设
计为用于数字信号处理的微处理器。

数字信号控制器（Digital Signal Controller）

数字信号控制器（Digital Signal Controller，DSC）是具有数字信号处理能力的单片机  
器件，如Microchip的dsPIC DSC器件。

顺序断点（Sequenced Breakpoints）

按顺序发生的断点。断点的执行顺序为从下到上；即序列中的最后一个断点最先发生。

T

特殊功能寄存器（Special Function Register，SFR）

数据存储器（RAM）的一部分，专用于控制 I/O处理器函数、I/O状态、定时器或其他
模式及外设的寄存器。

条件编译（Conditional Compilation）

只有当预处理器伪指令指定的某个常量表达式为真时才编译程序段的操作。

条件汇编（Conditional Assembly）

基于指定表达式在汇编时的值包含或忽略的汇编语言代码。

调试 /调试器（Debug/Debugger）

请参见 ICE/ICD。

调试信息（Debugging Information）

编译器和汇编器选项，在选中时，它们将提供不同程度的信息来用于调试应用程序代
码。关于选择调试选项的详细信息，请参见编译器或汇编器文档。

U
USB

通用串行总线。是计算机和外设之间通过电缆以双向串行传输方式通信的外部外设接
口标准。USB 1.0/1.1支持12 Mbps的数据传输速率。USB 2.0支持最高480 Mbps的数    
据传输速率，通常称为高速USB。

V
Volatile

阻止编译器应用会影响访问存储器中变量的方式的优化的变量限定符。

W

Watches窗口（Watches Window）

Watches窗口包含每次执行到断点时更新的观察变量的列表。

外部RAM（External RAM）

芯片外的读 /写存储器。
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外部标号（External Label）

有外部链接的标号。

外部符号（External Symbol）

具有外部链接的标识符符号。这可能是一个引用或一个定义。

外部符号解析（External Symbol Resolution）

链接器搜集所有输入模块的外部符号定义来解析所有外部符号引用的过程。没有相应
定义的任何外部符号引用都会导致报告链接器错误。

外部链接（External Linkage）

如果可以在定义函数或变量的模块外部对函数或变量进行引用，则函数或变量具有外
部链接。

外部输入线（External Input Line）

用于根据外部信号设置事件的外部输入信号逻辑探针线（TRIGIN）。

微处理器模式（Microprocessor Mode）

PIC18单片机的一种程序存储器配置。在微处理器模式下，不使用片内程序存储器。整
个程序存储器映射到外部。

伪指令（Directive）

源代码中所提供对语言工具的操作进行控制的语句。

尾数法（Endianness）

多字节对象中的字节存储顺序。

未初始化数据（Uninitialized Data）

定义时未指定初始值的数据。在C中，

int myVar; 

定义了将驻留在未初始化数据段的一个变量。

未分配段（Unassigned Section）

在链接器命令文件中尚未分配到特定目标存储器块的段。链接器必须找到用于分配未
分配段的目标存储器块。

文件寄存器（File Register）

片内数据存储器，包括通用寄存器（GPR）和特殊功能寄存器（SFR）。

X

系统窗口控件（System Window Control）

系统窗口控件位于窗口和某些对话框的左上角。单击该控件时通常会弹出包含
“Minimize”（最小化）、“Maximize”（最大化）和“Close”（关闭）项的菜单。

下载（Download）

下载是指将数据从主机发送到其他设备（如仿真器、编程器或目标板）的过程。

限定符（Qualifier）

次数计数器使用的地址或地址范围，或用作复杂触发中另一个操作之前的事件。
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响应延时（Latency）

事件与其得到响应之间的延迟时间。

向量（Vector）

复位或中断发生时应用程序跳转到的存储地址。

项目（Project）

项目包含编译应用程序（源代码和链接描述文件等）所需的文件以及这些文件与各种
编译工具和编译选项之间的关联。

消息（Message）

显示出来的文本，警告在语言工具的操作中可能存在的问题。消息不会停止操作。

小尾数法（Little Endian）

多字节数据的数据存储顺序机制，在这种机制中，低字节存储在较低的地址中。

修正（Fixup）

链接器重新定位后将目标文件符号引用替换为绝对地址的过程。

虚拟字节（Phantom Byte）

dsPIC架构中的未实现字节，在将24位指令字视为32位指令字时使用。虚拟字节出现
在dsPIC hex文件中。

序言（Prologue）

编译器生成代码的一部分，负责分配堆栈空间、保存寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。该代码在给定函数的任何用户代码之前执行。

Y

样机系统（Prototype System）

指用户目标应用或目标板的一个术语。

已初始化数据（Initialized Data）

定义时已指定初始值的数据。在C中，

int myVar=5;

定义了将存放到已初始化数据段中的一个变量。

已分配段（Assigned Section）

在链接器命令文件中已分配到目标存储器块的GCC编译器段。

异步（Asynchronously）

不同时发生的多个事件。通常用来指可能在处理器执行过程中的任意时刻发生的中断。

异步激励（Asynchronous Stimulus）

为模拟被模拟器件的外部输入而生成的数据。

应用（Application）

可以由PIC®单片机控制的一组软件和硬件。
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优先顺序（Precedence）

定义表达式中求值顺序的规则。

原始数据（Raw Data）

与一个段有关的代码或数据的二进制表示。

源代码（Source Code）

编程人员编写计算机程序所使用的形式。源代码以某种正规的编程语言编写，可翻译
成机器码或被解释程序执行。

源文件（Source File）

包含源代码的ASCII文本文件。

运算符（Operator）

加号“+”和减号“-”之类的符号，它们在构成定义明确的表达式时使用。每个运算
符都有用于确定求值顺序的指定优先级。

运行（Run）

将仿真器从暂停状态释放，允许仿真器实时运行应用代码、实时改变 I/O状态或实时响
应 I/O的命令。

运行时观察（Runtime Watch）

Watches窗口中的变量在应用程序运行时变化。要确定如何设置运行时观察，请参见
相应的工具文档。并非所有工具都支持运行时观察。

运行时模型（Run-time Model）

介绍目标架构资源的使用。

Z

暂停（Halt）

停止程序执行。执行Halt与在断点处停止相同。

针对相应器件的MPLAB入门工具包（MPLAB Starter Kit for Device）

Microchip的入门工具包中包含着手研究指定器件所需的全部资源。查看正在运行的应
用程序，然后对所做的更改进行调试和编程。

针对相应器件的MPLAB语言工具（MPLAB Language Tool for Device）

Microchip用于指定器件的C编译器、汇编器和链接器。根据应用要使用的器件选择语
言工具的类型，例如，如果要为PIC18 MCU创建C代码，请选择适合PIC18 MCU的  
MPLAB C编译器。

帧指针（Frame Pointer）

引用堆栈中地址，并将基于堆栈的参数和基于堆栈的局部变量分隔开的指针。为访问
当前函数的局部变量和其他值提供了方便。

只读存储器（Read Only Mmeory）

允许快速访问永久存储的数据，但不能增加或修改数据的存储器硬件。
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指令（Instruction）

告知中央处理单元执行特定操作，并可能包含操作中要使用数据的位序列。

指令集（Instruction Set）

特定处理器理解的机器语言指令的集合。

致命错误（Fatal Error）

引起编译立即停止的错误。不产生其他消息。

中断（Interrupt）

传递到CPU的信号，它使CPU暂停执行正在运行的应用程序，把控制权转交给中断服
务程序（Interrupt Service Routine,ISR），以处理事件。完成 ISR时，将恢复应用程序  
的正常执行。

中断处理程序（Interrupt Handler）

发生中断时处理特殊代码的子程序。

中断服务程序（Interrupt Service Routine，ISR）

语言工具——用于处理中断的函数。

MPLAB IDE/MPLAB X IDE——在产生中断时进入的用户生成的代码。代码在程序存储   
器中的位置通常取决于所产生中断的类型。

中断服务请求（Interrupt Service Request，IRQ）

使处理器暂停正常的指令执行并开始执行中断处理程序的事件。某些处理器有几种中
断请求事件，允许具有不同优先级的中断。

中断向量（Interrupt Vector）

中断服务程序或中断处理程序的地址。

中央处理单元（Central Processing Unit）

器件的一部分，负责取出要执行的正确指令，对指令进行译码，然后执行指令。需要
时，它和算术逻辑单元（Arithmetic Logic Unit，ALU）配合工作，来完成指令的执行。  
中央处理单元控制程序存储器地址总线、数据存储器地址总线以及堆栈的访问。

主机（Pod）

在线仿真器或调试器的外壳。其他名称还有“Puck”（如果外壳是圆的）和“Probe”
（不要与逻辑探头混淆）。

助记符（Mnemonics）

可直接翻译为机器码的文本指令。也称为操作码。

状态栏（Status Bar）

状态栏位于MPLAB IDE/MPLAB X IDE窗口的底部，指示诸如光标位置、开发模式、器   
件和有效工具栏之类的当前信息。

字母数字字符（Alphanumeric）

字母数字字符由字母字符和十进制数字（0,1, …,9）组成。

字母字符（Alphabetic Character）

字母字符指属于拉丁字母表（a, b, ..., z, A, B, …, Z）中字母的字符。

左值（L-value）

引用可被检查和 /或修改的对象的表达式。左值表达式用在赋值的左侧。
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